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Notices

Notice

Please do not attempt to operate or repair this equipment without adequate training. Any

use, operation or repair you perform that is not in accordance with the information contained

in this documentation is at your own risk.

Trademark Acknowledgments

Entrust, Sigma and the hexagon design are trademarks, registered trademarks and/or service

marks of the Entrust Corporation in the United States and other countries.

Datacard is a registered trademark and service mark of Entrust Corporation in the United

States and other countries.

MasterCard is a registered trademark of MasterCard International Incorporated.

Visa is a registered trademark of Visa International Service Association.

All other product names are the property of their respective owners.

Proprietary Notice

The design and information contained in these materials are protected by US and

international copyright laws.

All drawings and information herein are the property of Entrust Corporation. All unauthorized

use and reproduction is prohibited.

Entrust Corporation
1187 Park Place

Minneapolis, MN 55379

Phone: 952-933-1223

Fax: 952-933-7971

www.entrust.com

© 2025 Entrust Corporation. All Rights Reserved

http://www.entrust.com/


Safety
The following basic safety tips are given to ensure safe installation, operation, and

maintenance of Entrust equipment.

l Connect equipment to a grounded power source. Do not defeat or bypass the ground

lead.
l Place the equipment on a stable surface (table) and ensure floors in the work area are dry

and non-slip.
l Know the location of equipment branch circuit interrupters or circuit breakers and how

to turn them on and off in case of emergency.
l Know the location of fire extinguishers and how to use them. ABC type extinguishers

may be used on electrical fires.
l Know local procedures for first aid and emergency assistance at the customer facility.
l Use adequate lighting at the equipment location.
l Maintain the recommended temperature and humidity range in the equipment area.

Safe Human Interface
l Use proper lifting techniques when moving or installing the equipment.
l Use standard electrostatic discharge (ESD) precautions when working on or near

electrical circuits.
l Do not defeat or disconnect safety interlocks on covers.

! Warning: To avoid a possible electric shock, always unplug the

system before servicing.

Liability
The WARNING and CAUTION labels have been placed on the equipment for your safety.

Please do not attempt to operate or repair this equipment without adequate training. Any

use, operation, or repair in contravention of this document is at your own risk.

California Proposition 65 Compliance
WARNING: This product contains chemicals, including lead, known to the State of California
to cause cancer, and birth defects or other reproductive harm.Wash hands after handling.

! WARNING: Risk of cancer and reproductive harm from exposure

to lead and di(2-ethylhexyl) phthalate (DEHP), and risk of

reproductive harm from exposure to benzyl butyl phthalate (BBP).

See www.P65warnings.ca.gov.

Entrust Corporation believes that its products are not harmful when used as designed.

However, the above warning is made in compliance with the State of California Safe Drinking

Water and Toxic Enforcement Act of 1986, which requires warning labels on products that

may contain elements that the State of California considers harmful.

http://www.p65warnings.ca.gov/




Revision Log

Revision Version Date Description of Changes

A 1.0 October 2025 First release of this document.
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1Chapter 1: About the Card
Driver
The GDI Card Printer Driver uses Microsoft GDI print technology to support

printing from applications. This chapter provides a task overview of the

Card Printer Driver, and a description of the communication between the

Card Printer Driver and the card printer.

Supported Operating Systems
The following operating systems are supported by the Card Printer Driver (the latest service

pack is recommended):

l Windows 10 (64-bit)
l Windows 11 (64-bit)

For more information about PC and operating system requirements, refer to the printer’s

Installation and Administrator’s Guide.

Supported Printers
l Entrust® Sigma DS3 and DS3 with Card Lamination Module

! The GDI Card Printer Driver requires Sigma printer firmware

version D4.4.2 (or above). If a printer is not using a valid version

of firmware, the printer's LCD may display a 518-error message.

You must use the RFID Upgrade Kit to upgrade the firmware and

enable the GDI Driver (one kit per printer).
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Driver Task Overview
Refer to Install the Driver on page 18 for the steps to follow to install the printer and driver.

After the Card Printer Driver has been installed, it does the following:

l The Card Printer Driver receives card data from an application.
l The Card Printer Driver processes it for personalizing a card.
l Optionally, the Card Printer Driver encrypts data transactions with the printer for secure

printing.
l The Card Printer Driver sends the prepared data to the printer.
l The Card Printer Driver checks the printer for card completion.
l The Card Printer Driver displays any conditions (messages) associated with the card job.

i The information included in this guide does not apply to all

printers supported by the Card Printer Driver. Check your printer

configuration label to verify your printer model and the features

and options it includes.

Printer/Driver Communication
The printer communicates with the PC through the Card Printer Driver using either a USB

cable or an Ethernet cable. For both connection types, the printer treats communication as if

the PC is connected over a network.

l You can update printer settings using the Printer Manager web interface or the Printer

Dashboard. Refer to the printer’s Installation and Administrator’s Guide for information

about using Printer Manager, or the Printer Dashboard Help.
l You can customize applications to control card personalization features through the

Card Printer Driver. If you use a customized application, follow the instructions in your

application.
l Secure printing is available on current models of some Sigma printer models. Print jobs

are secured with data protection automatically when the printer is configured to

communicate securely. For more information, refer to Use the Card Printer Driver for

Secure Printing on page 25.

XPS and GDI Compatibility

The Entrust XPS Card Printer Driver and Entrust GDI Card Printer Driver can be installed on

the same computer. When both drivers are installed, there is a limit on the communication

types.

l If the GDI Card Printer Driver is installed, but not the XPS Card Printer Driver, network

and USB communication is supported.
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l If the XPS Card Printer Driver is installed, but not the GDI Card Printer Driver, network

and USB communication is supported.
l If the GDI Card Printer Driver and XPS Card Printer Driver are both installed, network

communication is supported and USB communication is not supported.

Printer/Driver Communications Over a Network
The Card Printer Driver requires the current printer IP address when it is connected to the

printer over a network. Refer to the printer’s User’s Guide for information on how to retrieve

the printer’s IP address.

When both the printer and the PC use an organization's network, the network affects the

speed of data transmission, and can affect who can use the printer. The network printer can

have many PCs connected to it, and each PC can be connected to multiple printers over the

network.

Printer/Driver Communications Using a USB Connection
Connecting the printer and a PC using a USB cable automatically creates a local network.

Each time another printer is connected to the PC, it creates a new local network for the new

printer.

You can connect up to eight printers to a PC using USB cables.

i Sigma card printers use a USB-C (USB 3.0) connection.

USB Communication Errors

Entrust recommends using DPCL2 when connecting to the printer using a USB connection.

To change to DPCL2 from DPCL2secure:

1. Log in to Printer Dashboard using the admin account.

2. Select Configuration > Settings from the menu.

3. Set Behavior > DPCL2Secure to Disabled.

4. Set Behavior > DPCLSecure to Disabled.

5. Verify that Behavior > DPCL2 is set to Enabled.

6. Scroll to the bottom of the page and click the Save button.

7. Select Troubleshooting > Restart Printer from the menu. The printer must be restarted

to change the DPCL settings.

8. After the printer restarts, connect to it using the GDI driver and review the Printer Status

tab for the connected printer. The Protocol line in the Printer Information list should

read: "Version 2".
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Printer/Driver Communications Using a Wi-Fi
Connection

Driver supports Wi-Fi communication with Sigma DS printers.

1. For more information about retrieving a Wi-Fi address, refer to the Wi-Fi Module

Upgrade Kit Manual.
l 528140-001 Wi-Fi Module Upgrade Kit Manual for Entrust Sigma DS Printers

2. Use the Ports tab on the Card Printer Driver Printer Properties window to enter the

printer’s IP address. Refer to Change a Network IP Address on page 31.
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2Chapter 2: GDI Card Printer
Driver Installation
This chapter provides information about how to install the Card Printer

Driver.

Before You Install
Be aware of the following as you plan to install the Card Printer Driver.

l Prepare the printer before installing the Card Printer Driver. Load the printer supplies

and cards as described in your printer’sQuick Install Guide or Installation and

Administrator’s Guide.
l The Card Printer Driver installation assigns a default printer name. Each printer must

have a different name. The installation automatically creates a unique name.

Installation Overview
Basic installation includes the following steps:

1. Identify Your Installation Requirements below.

2. Prepare to Install the Card Printer Driver on the next page.

3. Install the driver based on the printer to PC communication method you are using, either

a USB or a network connection. Refer to Install the Driver on page 18.

Advanced printer setup consists of:

l Connect More Than One Printer on page 23.
l Use the Card Printer Driver for Secure Printing on page 25.

Identify Your Installation Requirements
How you install and set up the Card Printer Driver depends on how many users print to the

card printer, the operating system you use to send card data, and other decisions specific to

your environment.

Use the following table to locate the information you need to install and use the Card Printer

Driver.
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If you want to Information

Install the Driver Refer to Start the Installation on the next page.

Download the
Driver

Download the Card Printer Driver installation file from the Entrust
website. Refer to Download the Installation File below.

Use a USB
Connection

Refer to Install the Driver on page 18.

Use a Network
Connection

Refer to Install the Driver on page 18.

Use Secure
Printing

Refer to Use the Card Printer Driver for Secure Printing on page 25.

Connect to More
Than One Printer

Refer to Connect More Than One Printer on page 23.

Prepare to Install the Card Printer Driver
This section provides information about installing the Card Printer Driver on a PC running a

supported Windows operating system. Refer to Supported Operating Systems on page 11

and the printer’s Installation and Administrator's Guide for complete information about

installation requirements.

Download the Installation File

You can install the driver from the downloaded Card Printer Driver installation file.

i Your network security configuration might prevent the download

or installation of the Card Printer Driver installation file. Ask your

network support personnel if you need assistance downloading

the file and installing the Card Printer Driver.

1. Download the current version of the installation file from the Entrust website:

https://www.entrust.com/support/instant-id-card-issuance-systems

2. Select your printer model.

3. Expand Drivers (you may need to scroll down the page).

4. Download the Card Printer Driver .exe file to your PC. The file has a name similar to

GDICardPrinter_x.x.x.exe, where x.x.x is the version number.

5. Continue with Start the Installation on the next page.

16 Chapter 2: GDI Card Printer Driver Installation

https://www.entrust.com/support/instant-id-card-issuance-systems


Start the Installation

1. Log on to the PC as an administrator.

2. Browse to the location on the PC where you saved the downloaded file. Double-click the

downloaded file.

i You can also launch the installer through a command prompt.

Change to the directory where the GDICardPrinter_x.x.x.exe is

located and then run that file.

3. Click Yes on the User Account Control dialog box if it displays.

i If you are installing the Card Printer Driver and the computer

has pending Windows updates, the driver installation stops

and the following message displays. Finish installing the

Windows updates, restart the computer, and then start the

driver installation again.

4. When the driver installerWelcome page displays, you can select to install the printer
based on a USB or a network connection. Continue with Install the Driver on the next

page.
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Install the Driver
The following instructions describe how to install the driver using either a USB or a network

connection. Most of the installation procedure is the same for either method; differences are

noted where necessary.

! If you are installing the driver with a USB connection, do not

connect the USB cable to the printer until instructed. If you start

this procedure with the USB cable connected, problems can

result.

1. Plug in and power on the printer. Make sure that the cards and supplies are loaded

correctly. Refer to the printer’sQuick Install Guide to prepare the printer.

The printer LCD panel displays Readywhen the printer is completely powered on.

2. On theWelcome page, select Install a Network Printer or Install a USB Printer.

3. The installer displays the license agreement. Read the license agreement and click

Accept.
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i If you are installing multiple copies of the driver, you only have

to accept the license agreement once.

The Card Printer Driver begins loading.

i l If you are using a USB connection, continue with step 4.
l If you are using a network connection, skip to step 5.
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USB Installation:

4. When prompted, connect the printer to the PC with a USB cable, as shown on your

screen.

Windows searches for the printer and connects the PC and printer. The Installing USB
Driver page displays.

Continue with step 9.

Network Installation:

5. Connect the printer to the network with an Ethernet cable.

6. Use the printer LCD panel menu system to retrieve the printer’s IP address. Press the

down arrow until the IP address displays and record the address. Refer to the printer’s

User’s Guide for complete information about how to retrieve the IP address.

i The Card Printer Driver supports both IPv4 and IPv6 addresses

for network-connected printers. Refer to your printer’s User’s

Guide for information about obtaining an IPv6 address.

7. Enter the IP address.

The Installing Network Driverwindow displays on your PC.

i Click Get IP Address to display a PDF document that
describes how to find the IPv4 address of the printer.
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a. When the installer displays the Printer Properties Ports tab, click Configure Port.

b. Type the IP address in the Printer Name or IP Address field on the Port Settings
window.
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i If you are entering an IPv6 address, make sure that you

enter the complete address. An IPv6 address requires

square brackets at the beginning and end of the address.

Contact your network administrator for more information

about the address mode being used.

8. ClickOK on the Port Settingswindow to save your settings and close the window. Then,

click Close on the Ports tab to close the Printer Propertieswindow.

9. When the Card Printer Driver is installed, the Installation Complete page displays. Test
the printer by printing a sample card. Make sure that Ready displays on the LCD screen,

and click Print Sample Card.
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For information about how to print a printer test card, refer to the printer’s User’s Guide.

10. Click Exit to close the install window.
l The printer icon displays in the Devices and Printers window. Refer to Card Printer

Driver Management Tasks on page 29 and Card Design Tasks on page 53.
l Click the Configure Printer button on the printer Status tab to view the Printer

Dashboard. For information about using the Printer Dashboard, refer to the Printer

Dashboard Help.

Advanced Setup
Advanced setup options help you set up your installation to fit your operation’s needs.

Advanced setup includes the following:

l Connect More Than One Printer below
l Use the Card Printer Driver for Secure Printing on page 25

Connect More Than One Printer
There are several options for connecting more than one printer to a PC. You can connect to

multiple printers installed on an Ethernet network, or connect multiple printers to a PC with

USB cables.

Print to More Than One Printer From One PC

When you print to more than one printer from one PC:
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l Keep track of the printer names. When messages display, the title bar of the message

displays the name of the printer that issued the message.
l Select the printer to use from within the card production application. Card jobs are sent

to the selected printer even if more than one card printer is attached to the PC.
l Each printer has its own icon in the Printers window, and each printer has separate

Properties and Printing Preferenceswindows. Settings are not shared among printers.
l Do not install a mix of non-secure and secure printers on PCs that require secure

printing. Refer to your printer’s Installation and Administrator’s Guide for more

information about printers that support secure communication.

Install Additional Network Printers

You can connect to multiple network printers from a single PC. To add a network printer,

start the GDI Card Printer Installer and follow the procedure for installing a network printer

described in Install the Driver on page 18. Do this for each additional printer you want to

install. Make sure that the IP address of each printer is available to enter when prompted

during the installation.

Install Additional USB Printers

Use the following guidelines to install more than one printer with USB cables:

l Connect and install one printer at a time. The PC cannot run more than one installation

program at a time.
l You can connect up to eight printers to a PC with USB cables.
l If you need to connect two card printers to a PC with one USB port, use an

independently powered, high-speed USB hub to which both printers can connect. Do

not daisy-chain multiple hubs. Self-powered hubs are recommended.
l Each printer must remain powered on and in the Ready state during installation.

For each USB printer installed after the initial USB installation, do the following:

1. Load supplies and power on the printer before starting the installation. Refer to the

printer’s User’s Guide for the steps to load cards and ribbon.

2. Log on to the PC as an administrator.

3. Connect the Ready printer to the PC with a USB cable.

4. The operating system detects the new device and begins installation. A pop-up window

may display during installation. If the operating system does not display a pop-up

window within a few minutes, check all cables and connections to the printer, and then

look at the PC’s Printerswindow to determine whether the icon for the new printer

displays. The software sometimes installs without displaying the pop-up window.
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Use the Card Printer Driver for Secure Printing
Secure printing encrypts print commands and card data and transmits the information

securely from the PC to the printer. When the Card Printer Driver detects that a printer is

enabled for secure communications, it encrypts the data before sending it to the printer.

Refer to your printer’s Installation and Administrator’s Guide for more information about

printers that support secure communication.

Secure Printing Overview

Printers can use one of three protocols for communication. These protocols are named for

the printer command language protocols used to send card print data between the Card

Printer Driver and the printer.

Protocol Secure/Non-Secure Port

DPCL Non-Secure 9100

DPCL2 Non-Secure 9100

DPCL2Secure Secure 9111

Printers are shipped with all communication protocols enabled. The Card Printer Driver can

establish communication with the printer using any of the enabled protocols. The driver uses

the DPCL2Secure protocol for secure communication with the printer. To ensure secure

communication, you must disable DPCL2. Printers that do not support secure printing use

DPCL only.

You specify the communication protocol to use through the Printer Manager web interface

or the Printer Dashboard. Refer to the printer’s Installation and Administrator’s Guide for

more information about secure printing requirements and how to use Printer Manager to

enable or disable a communication protocol. If you use the Printer Dashboard, refer to the

dashboard Help for more information. The following table shows the communication

protocol used by the Card Printer Driver based on the Printer Manager or Printer Dashboard

Behavior settings.

i The Behavior > DPCLSecure protocol is not supported by the
printer.
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Behavior Printer Settings Driver Behavior

DPCL DPCL2 DPCL2Secure Driver Uses:

Enabled Enabled Enabled DPCL2

Enabled Disabled Enabled DPCL2Secure

Enabled Disabled Disabled DPCL

Enabled Enabled Disabled DPCL2

Disabled Enabled Enabled DPCL2

Disabled Enabled Disabled DPCL2

Disabled Disabled Enabled DPCL2Secure

Disabled Disabled Disabled Communication fails

Set Up Secure Printing

Do the following to set up secure printing:

1. Install a printer that supports secure printing. Refer to the printer’s Installation and

Administrator’s Guide for a list of hardware and software requirements.

2. Install and set up the Card Printer Driver. Refer to Install the Driver on page 18.

3. Do one of the following to enable secure printing:
l If you use Printer Manager:

a. Sign on as a WebAdmin and select Printer Setting > Behavior.

b. Set DPCL2 to Disabled, and make sure that DPCL2Secure is set to Enabled.

Refer to the printer’s Installation and Administrator’s Guide for complete

information about using Printer Manager.

c. Click Set Current to save your changes.
l If you use the Printer Dashboard:

a. Sign on as a user with Administrator privileges.

b. From the Menu icon, select Configuration > Settings > Behavior.

c. Set DPCL2 to Disabled, and make sure that DPCL2Secure is set to Enabled.

Refer to the Printer Dashboard Help for more information.

d. Click Save to save your changes.
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4. Restart the printer and computer for the settings to take effect.

5. Connect your secure printers to the host and client PCs.

After secure printing is set up, the Card Printer Driver automatically detects and uses secure

printing during card production.
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3Chapter 3: Card Printer Driver
Management Tasks
Card Printer Driver management tasks are accessed through the Printer

Properties window.

This chapter provides information about the Card Printer Driver, including:

l The Printer Properties Window
o General Tab below
o Ports Tab on the next page
o Advanced Tab on page 33
o Color Management Tab on page 34
o Security Tab on page 34
o Printer Status Tab on page 36
o Hopper Status Tab on page 40
o Card Counts Tab on page 42
o Supplies Tab on page 44

The Printer Properties Window
The Printer Properties window allows you to view the settings and values that Windows uses

to communicate with and manage the printer.

To open the Printer Properties window, display the Devices and Printerswindow on your

system. Right-click the icon for the card printer and select Printer properties. The window
has several tabs that provide information about the printer, and allow you to define the

printer to the PC.

i The tabs on the Printer Properties window may differ depending

on your printer model. Differences are noted where necessary.

General Tab

The General tab contains basic information about the printer. Click Preferences to display
the Printing Preferences window, which has settings that define how the card prints. Refer

to Design Tasks in Windows Printing Preferences on page 54 for complete information about

using the Printing Preferences window.
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i If you rename the printer on the General tab, all settings on all

Printing Preferences tabs are reset to their default values, with no

warning message fromWindows. If you have specified custom

printing preferences settings, the changes will be lost. If you do

rename the printer, review and reset your Printing Preferences

settings, as needed.

i The Print Test Page button prints a Windows test page to verify

PC communication with the printer. On some operating systems,

the card printer prints only a small portion of the test page.

Entrust recommends that you use the Printer Status Tab to print a

sample card.

Ports Tab

Use the Ports tab to define the IP address of your printer to the PC. Refer to Install the Driver

on page 18 for information about defining a port during installation or when setting up a

printer pool.
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i The Ports tab of the Printer Properties window includes the

Enable Bidirectional Support check box. The Card Printer Driver
always uses bidirectional communication with the printer. Make

sure that this option is selected. Otherwise, all printing from the

Card Printer Driver is disabled.

View Network Information

When the printer and PC using the Card Printer Driver are connected on a network, the

network settings on the PC and the printer must match.

Use the Ports tab on the Card Printer Driver Printer Properties window to enter the printer’s

IP address. Refer to the Port Type section described in Printer Status Tab on page 36 to see

the current IP address setting.

If the printer is set to use DHCP (Dynamic Host Configuration Protocol), the IP address of the

printer can change when the printer is powered off and powered back on. If this occurs, the

Card Printer Driver issues error message 500.

If the printer IP address changes often, consider using static IP addressing to provide a more

reliable connection. Work with your network support group to identify the IP address, subnet

mask, and gateway address (if used). Then, refer to the printer’s Installation and

Administrator’s Guide for information about setting a static IP address.

i The Card Printer Driver supports both IPv4 and IPv6 addresses for

network-connected printers. Refer to your printer’s User’s Guide

for complete information about retrieving an IPv6 address.

Change a Network IP Address

If you are connecting your PC to a new network printer or if the printer IP address has

changed, you need to change the IP address that is defined in the Printer Properties Ports

tab.

1. Open the Printer Propertieswindow and select the Ports tab.

2. Select the installed network printer you want to change and click Configure Port.
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3. On the Configure Standard TCP/IP Port Monitor dialog box, enter the new IP address

for the printer.
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4. ClickOK to save the new settings and then click Close on the Printer Properties
window.

Advanced Tab

The Advanced tab contains additional printer settings. We recommend you keep the defaults

set when you install the Card Printer Driver.
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i l The Card Printer Driver does not support the following

options on the Advanced tab:
o The New Driver button.
o The Keep printed documents option.

l The Print directly to the printer option may not be available,
depending on your operating system.

Color Management Tab

Refer to the Printing Preferences window and the “Color Printing” section of your printer’s

Installation and Administrator’s Guide for more information.

Security Tab

Use the Security tab to set printer permissions. If the PC to which the printer is attached has

more than one user, set permissions that:

l Give users access to all features of the printer and Card Printer Driver, including

messages.
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l Display messages to inform users when they need to change the ribbon, load cards, or

fix problems.
l Prevent access to the printer by unauthorized users.

1. Log in to the PC as the Creator/Owner/Admin.

2. On the Printer Properties window, select the Security tab.
a. Review the Group or User Names list. If the names for which you want to specify

permissions do not appear in the list, add the names.

b. Click Add to open the Users and Groups dialog box.

c. Select a name and click Add. Repeat for each name you want to add. When you are

done adding names, clickOK to close the Users and Groups dialog box.

3. In the Group or User Names list, select the name for which you want to specify
permissions.

4. From the Permissions list, select the access for each user or group:
l To enable printing, select Allow permission for Print,Manage this printer, and
Manage documents.

l To prevent a user from printing to the card printer, select Deny for all permissions.

5. Click Apply to save the changes.

6. Repeat step 3 through step 5 to grant access to the printer for other users or groups.

7. ClickOK to close the Printer Propertieswindow.
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Printer Status Tab

The Printer Status tab displays the printer status, port type, IP address, printer information,

and any messages that apply to the printer.

1. On the Printer Propertieswindow, select the Printer Status tab.

The date and time the information was retrieved from the printer displays in the lower

left area of the tab.

2. Click Ask Printer for Update to get the latest information from the printer.

3. You can view and update printer settings using the printer’s Printer Manager web

interface or Printer Dashboard. Click Configure Printer to log into Printer Manager or to
start the Printer Dashboard. Refer to your printer’s Installation and Administrator’s

Guide for information about using Printer Manager, or the Printer Dashboard Help.

Printer Status

The printer status can display as one of the following:
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Icon Printer Status

Ready

The printer is not processing a card and is available to print.

Suspended

The printer was paused or it is processing a card from another PC that has an

error waiting.

Busy

The printer is processing a card or a command, or the printer menu system is

being used.

If the printer or a laminator is warming up, a message displays indicating the

percent complete. Click Ask Printer for Update to update the warm-up
percentage.

Message

The printer has issued a message for a card sent from this PC. The message

text displays.

Initializing

The printer is powering on.

Unavailable

The printer is off, is shutting down, or is not connected.

Port Type

The Port Type displays the connection type and the printer IP address:

l USB – The printer is connected locally via USB.
l Network – The printer is connected using a network connection. The network IP address
can be either IPv4 or IPv6.

Printer Information

The Printer Information box displays the following:
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Model Model name of the printer

Serial Number Printer serial number assigned at the factory

Firmware Version Version of the firmware currently installed in the printer

Protocol DPCL protocol used by the driver to communicate with the printer

Option Information Options or features included in this printer

Print a Driver Sample Card

You can print sample cards from the Printer Status tab to verify that the Card Printer Driver

and the printer are communicating.

l The printer sample card shows a basic ID card that can be printed with any ribbon that

the printer supports. The test card images and text do not change.
l The magnetic stripe test card is available when the printer includes a magnetic stripe

option. The magnetic stripe test card verifies that the Card Printer Driver sends magnetic

stripe data to the printer and that the printer encodes it. The test data cannot be

changed.

The Card Printer Driver includes the following sample cards:

l Printer Sample Card
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l 3-Track ISO Magnetic Stripe

Hints & Tips

l The Card Printer Driver sample cards use the settings specified in the Printing

Preferences Layoutwindow, except for the following: Orientation, Print on Both Sides,
and Rotate front side card image 180 degrees. Refer to Design Tasks in Windows

Printing Preferences on page 54 for information about specifying printing preferences.
l The name of the magnetic stripe sample card prints on the card.

To print a sample card:

1. Open the Printer Propertieswindow.

2. Select the Printer Status tab. If the printer status is something other than Ready or
Busy, determine why the printer is unavailable.

3. Click one of the following:
l Print Sample Card
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l Print Mag Stripe Test Card

The printer picks the card and prints it. If the card does not print, refer to the

“Troubleshooting” section of the printer’s User’s Guide to determine the cause of the

problem and try to print the sample card again.

Hopper Status Tab

The Hopper Status tab displays information about the input hoppers of Sigma printers. The

input hoppers contain sensors that provide additional information about whether cards are

loaded in the hopper and the type of card.

i The Hopper Status tab does not display if the printer hoppers do

not contain sensors.
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1. On the Printer Propertieswindow, click the Hopper Status tab.

2. Select the hopper for which you want to display information from the Select Hopper
drop-down list.

The Hopper Status tab provides the following information:

Select Hopper The hopper whose information displays on the tab.

Type The type of hopper.
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Status The status of the hopper.

Cards Present
There are cards in the hopper.

Empty
There are no cards in the hopper

Cannot Detect
The Card Printer Driver cannot detect if cards are

present in the hopper.

l You can select the hopper for which you want to view information, including the

exception hopper.
l The printer updates the information when you first display the Hopper Status tab or

when you select a different hopper.
l No information displays if the printer is unavailable.

Card Counts Tab

The Card Counts tab of the Printer Properties window shows the number of cards that have

been processed by the printer.

1. On the Printer Propertieswindow, click the Card Counts tab. The tab displays current
and total counts.
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2. Select the hopper for which you want to display information from the Input Hopper
drop-down list. The page displays the most recent card counts for the selected hopper.

If you select All, the total card counts for the printer display.

The Card Counts tab provides the following information:

Picked Total All the cards the printer has picked from the selected hopper. The
default is all the cards the printer has processed.

Current All cards picked since the last time the count was reset. Current counts
can be reset using Printer Manager.

Completed The number of cards that completed successfully.

Rejected The number of cards that did not process correctly.
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Lost The number of cards that were picked but did not exit the printer (for
example, a jammed card that had to be removed).

Since last
cleaned

The number of cards processed since the last time the printer was
cleaned.

l You can select the hopper for which you want to see the card count information,

including cards picked from the exception hopper or rear pick.
l The printer updates the card count information when you first display the Card Counts

tab or when you select a different hopper.
l The printer includes cards used for test cards and cleaning cards in the Picked count, but

not in Completed count.
l No information displays if the printer is unavailable.
l For Sigma card printers, click the Clean Printer button to start the Printer Dashboard.
When you sign into the dashboard, the Cleaning Card page displays, so you can start the

cleaning process from the dashboard. Refer to the Printer Dashboard Help for more

information.

i The Clean Printer button is not available for non-Sigma
printers.

Supplies Tab

The Supplies tab of the Printer Properties window shows the supplies installed in the printer,

including the type of supply, the estimated percentage remaining, the part number, and a

description of the supply, if one is available.

i The supplies information that displays is determined by the type

of printer and any additional installed components.

i For Sigma printers, click the Printer Supplies button to start the
Printer Dashboard. When you sign into the dashboard, the

Supplies Details page displays, so you can see the supply status in

the dashboard. Refer to the Printer Dashboard Help for more

information.

The Printer Supplies button is not available for non-Sigma
printers.
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1. Open the Printer Propertieswindow and click the Supplies tab.

2. The date and time the information was retrieved from the printer displays in the lower-

left area of the tab. To get the latest information from the printer, click Ask Printer for
Update.

The Card Printer Driver Supplies tab displays the following supply information:

Supply Status
OK

The supply is installed, and at least 10% of the roll

remains.

Low

The supply is installed, and less than 10% of the roll

remains.

Unknown

The supply is missing or is not valid.
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Remaining The percent of supply remaining.

Supply The name of the installed supply.

Part Number The part number of the supply. (If a part number is not available, a

series of dashes displays.)

Ribbons that have a region code display with a prefix of -Rxxx before

the part number, where xxx is the region code.

If using a Sigma printer, the region code is -Sxxxx.

Description A short description of the supply, if one is available. If an installed

supply is not supported by the printer, “Not supported” displays. If a

supply is not installed, “Not installed” displays.

Administration Tab

Language Support

The GDI Card Printer Driver is in US English.

About Tab

The About tab shows the Card Printer Driver version and any additional information about the

driver.

1. On the Printer Propertieswindow, click the About tab.

2. ClickOK to close the Printer Propertieswindow.
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Uninstall the Card Printer Driver
You can uninstall the Card Printer Driver using either the downloaded file or the uninstall

utility from the Windows Start menu.

i You must restart your computer after uninstalling the Card Printer

Driver.

Prepare for Uninstall

1. Log on to the PC as an administrator.

2. Make sure that there are no documents waiting to print before removing the printer.

Right-click the printer icon and select See what’s printing.

i The Card Printer Driver occasionally issues a message that it

cannot complete the uninstall because there are active print

jobs. This situation can occur even when all printers have been

removed. Refer to Update or Uninstall Cannot Complete on

page 81 to resolve the issue.

3. Unplug the USB cables, if connected.

! If the USB printer is connected or not in the Ready state prior
to running the uninstall, the USB driver may not install the next

time you attempt to install the same printer to the PC. Refer

to Reinstall the GDI USB Card Printer Driver on page 76 for

information about how to remove any driver files that were

not removed during the uninstall process.

4. Use one of the following methods to remove the Card Printer Driver from your system.
l Use the Driver Installation File below
l Use the Start Menu Uninstall Program on page 49

Use the Driver Installation File

1. Double-click the GDICardPrinter_x.x.x.exe file.

i You can also launch the installer through a command prompt.

Change to the directory where the GDICardPrinter_x.x.x.exe is

located and then run that file.

The Card Printer Driver installWelcome page displays.

2. Click the wastebasket button to start the uninstall process.
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3. The Remove the Printer Driver from the PCwindow displays. Click Remove the Driver.

4. The GDI Card Printer Uninstall dialog box displays. If the printer is connected via a USB
cable, make sure that the cable is disconnected from the PC. If the printer connects to a

network via Ethernet, you can continue with the uninstall. ClickOK to continue.

An activity indicator displays as the Card Printer Driver is being removed.

48 Chapter 3: Card Printer Driver Management Tasks



The Driver removed screen displays.

5. Click Restart Now.

Use the Start Menu Uninstall Program

1. From the Windows Start menu, select GDI Card Printer Uninstall. You also click the
Search box, type GDI and select GDI Card Printer Uninstall.
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2. The GDI Card Printer Uninstall dialog box displays. If the printer is connected through
USB, make sure that the cable is disconnected from the PC. If the printer connects to a

network via Ethernet, you can continue with the uninstall. ClickOK to continue.

3. The GDI Card Printer Uninstall dialog box displays a warning that no printer activity
occurs while the driver files are removed. ClickOK to continue.

4. A dialog box confirms the uninstall is complete.

5. Restart your PC following the uninstall. Click Yes to restart. ClickNo to restart the PC at

a later time.
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The Card Printer Driver uninstall program requires the PC to be restarted after the uninstall

completes.
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4Chapter 4: Card Design Tasks
This chapter provides information about card design tasks you can perform

with the Card Printer Driver.

Use the following information to fine tune your card design and set up your card printing

preferences:

l Change a Card Design below
l Design Tasks in Windows Printing Preferences on the next page

o Layout Tab on page 55
o Paper/Quality Tab on page 58
o Advanced Options on page 58
o Print Area Tab on page 58
o Lamination Tab on page 61

l Escapes on page 64

Change a Card Design
Card design refers to the combined features of the printed cards.

An organization can change:

l The arrangement of card components, such as moving a photo to a different position on

the card.
l The source for card components, such as using a different camera for taking photos, or

using a new file for a logo.
l The components on the card, such as adding a magnetic stripe, a logo, or a bar code.

Whenever the card design changes, review the settings used for the card. Use this checklist

to guide your changes. Always:

l Use high-quality photos and graphics.
l Print several samples of the updated card design.
l Use cards with a magnetic stripe or bar code in a reader to verify that the data works as

expected.
l Check the Color Adjustment settings if you change a graphic on the card, change the

camera for taking photos, or change the location where photos are taken. Refer to
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“Color Printing” in your printer’s Installation and Administrator’s Guide for information

about how to improve the appearance on one element on a card.
l Refer to your printer’s Installation and Administrator’s Guide if you are changing a bar

code or magnetic stripe.

Bar Code Type Support

The following supported bar codes list is specific to the Lenel OnGuard platform.

l Aztec
l Codabar
l Code 128 Auto
l Code 128 A
l Code 128 B
l Code 128 C
l Code 3of9 2:1
l Code 3of9 3:1
l Code 93
l EAN13
l EAN8
l Extended Code 3 of 9 2:1
l Extended Code 3 of 9 3:1
l Extended Code 93
l Interleaved 2 of 5
l PDF417
l UCC-128
l UPCA

Design Tasks in Windows Printing Preferences
The Printing Preferences window allows you to specify default settings that define how your

card prints. The values set in the Printing Preferences window are used for all cards printed

using the Card Printer Driver unless they are overridden by your card design application or by

using an escape.

Do the following to open the Printing Preferences window:

1. Display the Devices and Printerswindow on your system.

2. Right-click the icon for the card printer and select Printing preferences.

Use the Printing Preferences tabs to set up your printing preferences.
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i The tabs and options that display in the Printing Preferences

window are determined by the printer model and the options

installed on the printer. Because the Card Printer Driver supports

multiple printer models, the information in the following sections

may not apply to all printers. Specific exceptions are noted,

where necessary.

Layout Tab

The Layout tab displays when you first select Printing preferences. Use the Layout tab to
select the orientation of the card (either Portrait or Landscape) and specify whether to print

on both sides of the card.

Click Advanced to display the Advanced Optionswindow, which allows you to define
additional printing settings. Refer to Advanced Options on page 58 for complete information

about specifying additional options.

Print on Both Sides of the Card

You can print on both sides of the card using the Card Printer Driver. The method for printing

on both sides depends on the printer model.

l Printers that include a duplex printingmodule automatically turn the card to print on
both sides. Check the printer configuration label to determine whether your printer

includes duplex printing. Refer to your printer’s User’s Guide for more information about

reading the configuration label.
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l Simplex printers support manual duplex printing. The printer prints one side of the card,
places the card in the card output hopper, and displays the message Insert same card
side 2 up. Insert the card into the hopper or manual-feed slot to print on the second
side.

Set Up Duplex Printing

Use card production software or another PC application to create a card design.

i The following example shows how to set up Microsoft Word for

duplex printing.

1. Do the following to set up printing preferences.

a. Open the printer’s Printing Preferenceswindow.

b. On the Layout tab, select Flip on Short Edge from the Print on Both Sides drop-
down list.

c. Click Apply.

2. Start your application and select the card printer as the current printer.

3. Use the application’s page setup options to set the correct paper size for your printer.
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Printer Paper Size Dimensions

Direct-to-Card Printers ISO ID-1 2.13 x 3.38 in.

4. Set the margins to 0.

5. Format the text and graphics to print on the card.

Refer to the printer’s Installation and Administrator’s Guide for more information about

card design.

i Your PC application’s Print settings may override the settings

specified in the Card Printer Driver. Make sure that your

application’s Print settings specify “Print on both sides.”
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Paper/Quality Tab

When Color is selected, the color and black data is printed correctly on the card.

When Black & White is selected, only the black data is printed on the card. Color data is not
printed on the card.

Advanced Options

Use the Advanced Options window to specify additional print settings. The following

sections describe each of the Advanced options.

Paper Size

1. Open the Printing Preferenceswindow.

2. On the Layout tab, click Advanced.

The correct paper size for your printer displays.

Printer Type Paper Size

Direct-to-card printers ISO ID-1 (85.60 x 53.98 mm)

i The Card Printer Driver does not support Copy Count.

Print Area Tab

The Print Area tab allows you to specify printing and non-printing areas on the card.

Print and Topcoat Blocking

The Card Printer Driver can prevent printing and topcoat application on specific areas of the

card. This includes the magnetic stripe, smart card chip, signature panel, or another area that

must remain unprinted or without topcoat.
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The Print Area tab provides a selection of standard blocking patterns that use a driver preset

mask, which automatically applies the proper dimensions and locations of a smart card chip

and magnetic stripes for print blocking. For more information about non-printing areas of a

card, refer to the printer’s Installation and Administrator’s Guide.

i If the predefined blocking selections offered by the Card Printer

Driver do not fit the card design, you can use escapes to define

custom rectangular areas for printing and topcoat application,

including defining more than one blocking area per side of a card.

Refer to Print Blocking Escapes on page 65.

To return the Print Area tab to the default settings, click Restore Defaults. The default print
and topcoat settings are:

l Front Side Print Area: Print and topcoat entire side of card.
l Back Side Print Area: Print and topcoat entire side of card.
l Custom bitmap is not selected.

Select a Preset Mask

Do the following to select a preset mask for magnetic stripe or smart card areas:

1. Open the Printing Preferenceswindow.

2. Select the Print Area tab.

3. For the side of the card with the non-printing area, select Block printing and topcoat
over this area, and then select the area from the list.
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The Print Blocking and Topcoat Blocking icons display the location of the card element.

The example shown blocks printing and topcoat application on the ISO 3-Track

Magnetic Stripe area on the back of the card. The text shown on the back of the card

design is formatted with a magnetic stripe font and is encoded.
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4. Click Apply to save the setting, and then clickOK.

5. Send the card to print.

The back of the completed card looks like the following:

The narrow white area above and below the magnetic stripe indicates the non-printing area.

It is slightly larger than the feature, in this case the magnetic stripe.

Lamination Tab

The Lamination tab displays only if the printer is part of a laminator system. It allows you to

specify how you want to apply overlay material to your card.

The laminator system can have one or two laminators (labeled L1 and L2) that can apply a

patch or topcoat overlay to one or both sides of a card. Refer to your printer’s User’s Guide

and Installation and Administrator’s Guide for complete information about setting up a

laminator system and the types of overlay materials available.

You can use escapes to override the printing preferences set on the Lamination tab on a

card-by-card basis. Refer to Laminator Escape on page 71.

For ribbon options such as YMCKT, KT, and YMCKT-KT, use of only DuraShield clear overlay

must be used with print ribbons that include a “T” panel and applied to same card side over

“T” panel.

GDI Card Printer Driver User Guide 61



Apply an Overlay

Do the following to specify lamination settings:

1. Open the Printing Preferenceswindow.

2. Select the Lamination tab.

3. Select a Laminate card option for each laminator. You can select from the following:

l Do not apply – No overlay material is applied.
l Front side only – Applies the overlay to the front of the card.
l Back side only – Applies the overlay to the back of the card.
l Both sides – Applies the overlay material to both sides of the card.
l Twice on front side – Applies two layers of the overlay material to the front of the
card. Use this option only with a topcoat overlay.

4. Click Apply to save your changes, and then clickOK to close the Printing Preferences
window.
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i The default Laminate card setting for both L1 and L2 is Do not
apply. You must specify a lamination option on the Lamination
tab or no overlay material is applied to the card.

i If an L2 laminator is not installed,Not installed displays and the
L2 options are not available.

Debow the Card

When you apply an overlay to a card, the card may become bowed slightly due to heat from

the laminator.

Select the Debow card option on the Lamination tab to use the debow mechanism in the

laminator to return the card to its proper shape.

l The Debow card option is not selected by default. You must select the option after

setting the lamination options.
l If you use ID software to specify lamination options, you can select the Debow card

option on the Lamination tab to make sure that cards are debowed after they are
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laminated. You also can use a debow escape to debow the card. Refer to Laminator

Escape on page 71.
l The debow settings—such as the amount (distance) of debow, the direction of debow

(up or down), and the time the debow action is applied—are set in Printer Manager or

the Printer Dashboard. You may need to print several cards to determine the best debow

settings for your card type. Refer to your printer’s Installation and Administrator’s Guide

for information about using Printer Manager, or the Printer Dashboard Help.

About Tab

The About tab shows the Card Printer Driver version and additional information about the

driver.

Monochrome Ribbon Support
It is best to use a black font color when printing with a monochrome ribbon regardless of the

monochrome color inserted in the printer. This is true for panelized and continuous

monochrome ribbons. The printed color on the card will match the color of the ribbon in the

printer.

Escapes
Escapes are formatted text that the Card Printer Driver converts to printer commands to

support a number of operations, including the following:

l Block printing
l Apply topcoat
l Encode magnetic stripe data
l Laminate a card
l Debow a card in the laminator

Escapes override printing preferences set in the Card Printer Driver or in a card design

application. You can use escapes to change printing controls on a card-by-card basis without

having to reset your printing preferences.

Hints & Tips

l For each escape, make sure that the text is consistent (use the same font, font size, and

color). Use a common font that is easy to see, and is different from, the text you want to

print on the card.
l Each escape must fit on a single line with no formatting or carriage returns. Use a small

font size to make sure that there is enough room for long escape strings.
l Do not align escape text to be on the same horizontal line as printed text.
l Make each escape its own line of text on the card design.
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l Do not place the escape as the first line at the top of the card design page when using

Microsoft Word.

Print Blocking Escapes

The Card Printer Driver provides several methods to prevent printing and topcoat on specific

areas of the card. Refer to “Non-Printing Areas” in your printer’s Installation and

Administrator’s Guide and Print Area Tab on page 58 for more information.

By default, the entire surface of the card is available for printing and topcoating. But when

cards have a magnetic stripe, a smart card chip, or another non-printable area, such as a

signature panel or hologram, you must define those areas so that the printer does not print or

apply topcoat to them.

Use escapes to block non-standard areas, or to define more than one blocking area per side

of a card. Escapes are specific sequences of characters that mark data with a special

purpose. The Card Printer Driver recognizes the following types of print blocking and topcoat

escapes:

l Print Block (PB)
l Topcoat Add (TA)
l Topcoat Remove (TR)

About Non-Printing Areas

l If the card has more than one non-printing area on a side (for example, a magnetic stripe

and a signature panel), you must define all non-printing areas using print blocking

escapes. An escape applies to the side of the card where it appears in the card design.
l Non-printing areas defined using print blocking escapes always override the driver

Printing Preferences settings.
l Each print blocking area defined by an escape is a rectangular shape.
l Each blocking rectangle is defined by four values separated by a space.
l You can specify more than one area of the same type in the escape string by placing a

semicolon (;) character between each set of values.

Print Blocking Syntax

The syntax or structure of each print blocking escape is ~XX%n1 n2 n3 n4?, where:

~ The beginning of the escape.
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XX The type of action:

PB—Print Block

TA—Topcoat Add

TR—Topcoat Remove

% The start of values.

n1* The distance (in mm) from the top of the card to the start of the print blocking
area.

n2* The distance (in mm) from the left edge of the card to the start of the print
blocking area.

n3* The width (in mm) of the print blocking area.

n4 The height (in mm) of the print blocking area.

? The end of the escape.

* Separate the measurements with a space when entering the escape.

Print Blocking in a Direct-to-Card Printer

The following examples show how to determine the values for the block print escape.

i The dimensions shown in the following examples are for general

reference. The size, shape, and location of the magnetic stripe,

smart card chip, or signature panel can vary based on the card

stock you use. Test your escapes to make sure that the blocking

areas are correct.

i Blocking typically extends 0.05 inch (1.27 mm) outside the edges

of a feature. The diagrams and dimensions shown include the

extended blocking region.

The following example shows the direct-to-card print blocking dimensions for a three-track

magnetic stripe area.

66 Chapter 4: Card Design Tasks



The following example shows sample direct-to-card print blocking dimensions for a smart

card chip. The actual measurements can vary depending on the size and location of the chip.

Block Print Escape

A block print escape begins with ~PB%.

Examples:

~PB%10 10 55 15? Printing is blocked in one area.

~PB%3.2 0 86 14.7;20
13 60 9?

Printing is blocked in two areas, such as a magnetic stripe and
signature panel.

~PB%? No printing is blocked on the current card.
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Topcoat Add Escape

The topcoat add escape applies topcoat only in the area defined in the escape. Topcoat is

not applied to other areas of the card. All full-color printing should be covered with topcoat,

so use this option with care.

The topcoat add escape begins with ~TA%.

Examples:

~TA%0 0 85.6 37? Topcoat is applied to one large area of the card.

~TA%16.8 0 37.1 5;30.5 45.23 15 15? Topcoat is applied in two areas.

Topcoat Remove Escape

With a topcoat remove escape, the topcoat is not applied to the areas defined by the

escape. All other areas of the card have topcoat.

The topcoat remove escape begins with ~TR%.

Full-Card Topcoat Options

l Use the escape ~TR%? to override the Card Printer Driver preset masks and topcoat the
entire card side.

l Use the escape ~TA%? to override the Card Printer Driver preset masks and apply no
topcoat to the entire card side.

Print several cards using your card design and application to verify that printing and topcoat

are applied as you intend.

Magnetic Stripe Escapes

Use magnetic stripe escapes when an application cannot format magnetic stripe data. The

data to encode on a magnetic stripe is entered as text and can look like data to print. The

Card Printer Driver uses the magnetic stripe escapes to identify the data to encode. Data

contained within the escape is not printed.

! If you are using the Lenel OnGuard platform, the use of a

semicolon in a magstripe escape code will fail. Replace the

semicolon ; with a percent % symbol.

Supported Escapes

The escape defines the track for the data. Because the data format for each track is set in the

printer, you must enter the type of data the format requires. The Card Printer Driver supports
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several escape systems that allow compatibility with card designs defined for various card

printers. The following table shows the default ISO data format for each track. The Syntax

column shows the general escape format for providing data to the printer. The Example

column shows how the data looks when formatted.

Syntax Track Example

~<track#> <Start Sentinel> <data> <End

Sentinel>

The only Start Sentinel permitted for tracks 2

and 3 is a semicolon (;)

Used by Entrust Datacard, JVC, and Fargo

printers

1 (IATA) ~1%ENCODINGWITH
ESCAPES?

2 (ABA) ~2;1234567890?

3 (TTS) ~3;1234567890?

~<track#><data>

Used by Eltron/Zebra printers

1 (IATA) ~1ENCODINGWITH
ESCAPES

2 (ABA) ~21234567890

3 (TTS) ~31234567890

~<track#>=<data>

Used by Atlantek printers

1 (IATA) ~1=ENCODINGWITH
ESCAPES

2 (ABA) ~2=1234567890

3 (TTS) ~3=1234567890

! If you are using the Lenel OnGuard platform, the use of a

semicolon in a magstripe escape code will fail. Replace the

semicolon ; with a percent % symbol.

Set Up Magnetic Stripe Escapes

1. Format the text and graphics to print on the card. Use card production software or

another application to create the card design.

2. Type the encode data (text) for one track. Locate an area on the card where typing the

data to encode does not affect other card design components.
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The example shown uses the syntax: ~<track#><Start Sentinel><Data> <End Sentinel>

The text for track 1 has the format: ~1%Zachary Hamilton 12345 Finance?

3. Repeat step 2 for each track of magnetic stripe data.

4. With magnetic stripe cards in the printer, send the card to print.

5. Verify the encoding was successful by passing the card through a magnetic stripe

reader.

Hints & Tips

l Do not put data for two tracks on the same line.
l Use a small font size to keep the text to encode on one line. Do not allow the text to

encode to wrap to another line.
l Do not enter data to print on the same line as data to encode. It will not print.
l If necessary, you can use two or more lines of text for one track. Start and end each line

with escapes, and enter a carriage return at the end of the line. The Card Printer Driver

adds (appends) lines for the same track together.

When the Card Printer Driver adds lines of text for the same track, the sequence is

determined by the application. Test your application with the Card Printer Driver to make

sure that the data is in the correct order.

l The data to encode can be on side 1 (front) or side 2 (back) of the card design. Magnetic

stripe data sent by the Card Printer Driver is always encoded on side 2 of the card.
l Magnetic stripe data is converted to uppercase letters if needed.
l The printer displays a message if characters unsupported by a track format are sent in

the magnetic stripe data.
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Laminator Escape

Lamination systems can use escapes to control the application of overlay on a card and to

debow the card.

! If you are using the Lenel OnGuard platform, the use of a

semicolon in a laminator escape code will fail. There is no

workaround for this issue.

The syntax for a laminator escape is ~LM%Lxy;D?, where:

~ Indicates the beginning of the escape.

LM Identifies the escape as a laminator escape.

% Indicates the start of laminator values.

L Indicates a laminator action.

x Specifies the laminator number to use, where x = 1 or 2.

y Specifies the card side to laminate. y can have the following values: F (front), B
(back), A (both sides), T (front side twice), or N (do not apply).

; A separator character that allows you to specify more than one lamination
option in the escape.

D Debows the card.

? Indicates the end of the escape.

Examples:

~LM%L1F;L2B;D? Laminate front side using L1, back side using L2, debow the card.

~LM%L1A;D? Laminate both sides using L1, debow the card.

~LM%L1T? Laminate front side twice using L1; the card is not debowed.
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~LM%D? Debow the card only (no overlay is applied).

~LM%L1N;L2N? Do not laminate the card. Use this escape to override the
Laminate card settings in the Printing Preferences Lamination
tab, for example, for a single card.

Hints & Tips

l The order of the escape Lxy elements is not important. The Card Printer Driver orders the

L1 and L2 lamination and debow actions in the proper sequence.
l The escape control characters are not case-sensitive.
l Leading and trailing spaces in the escape string are removed by the Card Printer Driver.
l Only one escape is used.

o If more than one escape is entered in the same text string, only the first escape is

used. Subsequent escapes, even if they are valid, are not processed.
o If multiple escapes are entered separately, only the last escape is used.

l Embedded spaces in the escape string make the escape invalid.
l Invalid escapes print on the card as regular text. This provides a record of what went

wrong and lets you know that the card was not laminated. The following can invalidate

an escape:
o A missing laminator number or any character other than 1 or 2.
o A missing laminator action or any character other than F, B, A, T, or N.
o More than one instance of a laminator number (for example, ~LM%L1F;L1B? has two

L1 actions).

l If a laminator is not installed, the escape is ignored and the card prints using other valid

job options. No error messages are issued.
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5Chapter 5: Card Printer
Driver Troubleshooting
This chapter provides guidance for several categories of issues.

This chapter describes the following:

l Installation Troubleshooting below
l Additional USB Troubleshooting on page 81
l Update or Uninstall Cannot Complete on page 81
l Antivirus Software Troubleshooting on page 82
l Additional Driver Troubleshooting on page 82
l Advanced Troubleshooting Tools on page 83

Installation Troubleshooting
You can download the driver from the Entrust website.

This section describes issues that could prevent a successful installation and provides

recommended solutions to those issues. Select from the following topics:

l USB Installation Troubleshooting below
l Network Installation Troubleshooting on page 80

USB Installation Troubleshooting

Problem Solution

The cable is loose. Reconnect the USB cable to the ports on the PC

and the printer. Power the printer off, and then

back on. If the PC and printer still do not

communicate, restart the PC.
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Problem Solution

The data cable is damaged or

frayed.

Power off the printer. Replace the cable if you

have a spare. Contact your service provider to

order a new data cable.

The system has a temporary

communication problem.

Check the following:

l USB extension cables can cause

communication problems. The

recommended USB cable is 6-ft. (2 meters)

long. Make sure that the cable is rated for

USB 2.0 or USB-C (3.0) data transmission.
l If you are using a USB hub, a self-powered

hub is recommended.

The card printer does not install

when the USB cable is connected.

If a previous printer installation attempt was

unsuccessful, Device Manager might still show

an entry for the printer.

Remove the printer entry from Device Manager

before reinstalling the printer:

1. Disconnect the printer from the PC.

2. Open theWindows Device Manager.

3. Locate the device to delete. The device

might be called “Unknown device” or it

might be located under the Printers or

Network Adapters folder. The device might

be marked with a yellow question mark or

exclamation point.

4. Select the device, and right-click to display

a pop-up menu.

5. Select Remove device from the pop-up

menu.

6. Click Yes orOK to confirm removal of the

device.

7. Close the Device Manager. Close any other
windows.

8. Reinstall the printer.
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Problem Solution

Error message states the USB is not

detected.

The USB installer timed out before a printer was

detected.

Remove the Card Printer Driver from the Device

Manager before reinstalling the printer.

The USB cable is connected before

the Card Printer Driver is installed.

Connect the USB cable to the printer when you

are prompted. Do not connect the cable before

starting the installation.

The Print Sample Card button is not

available.

The Print Sample Card button in Printer

Properties is enabled when the printer and Card

Printer Driver communicate normally. If Print

Sample Card is not available, make sure that

Ready displays on the printer LCD panel.

Note: The Print Sample Card button is not

available when printer pooling is enabled.

The PC USB port does not

communicate with the printer USB

port.

Power management on the PC has shut down

USB communication. Check the following:

l Open the Windows Device Manager and

display the list of USB devices. Disable

shutdown for each hub in the list. Restart

the PC for the changes to take effect, if

necessary.
l Hibernation on a laptop PC requires several

moments to enable USB communication.

Unplug the USB printer port and then

connect it again.
l Replace the PC port or the PC. Contact your

PC or port vendor if you need assistance.
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Problem Solution

The printer does not install or print

on the PC when the PC is

connected to a remote network

using VPN Client software.

VPN Client software can prevent the installation

and use of other devices. Choose one of the

following solutions:

l Configure your VPN software to allow local

network connections.
l Disconnect the VPN Client software from

the network. Then, install the USB printer

and Card Printer Driver, or resume printing.

The USB printer driver fails to install

on a PC that had a previous USB

driver installed.

The USB printer was not uninstalled correctly.

Refer to Reinstall the GDI USB Card Printer

Driver below.

Installing the Card Printer Driver

while printing cards causes printing

to fail.

Printing to a USB printer fails with error 505, USB

communication issue, if a new network or USB

driver install is started while printing cards.

Restart the PC to recover. Make sure that all

cards have finished printing and there are no

print jobs in the print queue before starting a

new driver install.

Multiple USB printers are installed

when a Sigma printer is connected

to the PC while powering it on. The

printer Names is set to “1” on the

Configure Standard TCP/IP Port

Monitor dialog box. The USB printer

does not print.

Upgrade to firmware version 4.4.2 or connect

the printer to the PC once it is fully powered on.

Reinstall the GDI USB Card Printer Driver

The Card Printer Driver uninstall program requires the PC to be restarted after the uninstall

completes. Refer to Uninstall the Card Printer Driver on page 47 for complete uninstall

instructions.

There may be occasions when it is not possible to complete one, or more, of these steps

during the uninstall process. For example:
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l The printer is unplugged and temporarily moved to another location.
l The printer is not powered on when the uninstall starts.

If the USB printer is connected and in Ready status prior to running the uninstall, some of the

Card Printer Driver support files may not be removed from the PC. If you then attempt to

reinstall the same printer to the PC, the USB driver may not install and issue an error.

Use the following procedure to reinstall the USB Card Printer Driver.

i Some of the steps described in this procedure may not apply in all

situations. Continue with the procedure to remove the Card

Printer Driver files.

i The screens on your computer may differ from those shown in

the illustrations, depending on your operating system. The

information applies to all operating systems.

1. If the printer is available and Ready, plug in the USB cable to the PC.

2. Open the Windows Devices and Printerswindow. If the GDI Card Printer device displays
in the window, do the following to remove the device:

On the Devices and Printerswindow, right-click the icon for the GDI Card Printer and
select Remove device from the menu. This removes the GDI Card Printer icon from the

list of printers. If there are multiple GDI Card Printer icons, do this for each one.

i If the GDI Card Printer Driver icon does not appear in the

Devices and Printers window, continue with step 3.
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3. Right-click in the Devices and Printerswindow and select Device Manager.

4. In the Device Managerwindow, select View > Show Hidden Devices.
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5. Expand theNetwork Adapters list. A list of all network adapters installed on the

computer displays.

Do one of the following to remove the device:

l If the printer is plugged in to the computer, the GDI Card Printer High Speed USB

Connection entry displays in the list of network adapters. Right-click the entry and

select Uninstall (or Uninstall device) from the menu.
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i The entry may be followed by an exclamation mark or

question mark.

If a confirmation window displays, confirm that you want to delete the device. This

uninstalls the device and removes the adapter from the list.

l If the printer is not plugged in to the computer, the GDI Card Printer High Speed

USB Connection entry does not display in the list of network adapters. Run the GDI

Card Printer Uninstall program from the Windows Start menu to remove the driver

files.

6. Unplug the printer USB cable from the computer, if it is plugged in.

7. Restart the computer.

8. Install the GDI Card Printer Driver as described in Install the Driver on page 18.

Network Installation Troubleshooting

Problem Solution

The network cable is loose. Reconnect the data cable to the network port and the

printer, making sure that it is snapped in. Restart the

printer.
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Problem Solution

The Status page of Printer

Properties shows the printer

is not available, but the

printer displays Ready on

the LCD screen.

Follow your network troubleshooting procedures to

isolate and test each component of the computer-to-

printer communication link.

Suggestions:

l Check the computer-to-network connection by

accessing a network resource, such as a network

drive.
l Have the network administrator test communication

between a server and the printer.
l Make sure that the user is logged in to the network.

The printer is not configured

with the correct network

address.

Make sure that the server name or IP address has been

entered correctly in the Port Settings or Configure Port

dialog box on the computer. For information about

retrieving the printer’s IP address, refer to the card

printer’s User’s Guide.

Make sure that Ready displays on the printer's LCD panel.

Additional USB Troubleshooting
l If a USB-connected printer is powered on before the computer, the printer may appear

as offline and cards sent to the printer do not print. Power on the computer first to

prevent this from occurring. To remedy the offline status, unplug the printer's USB cable

and then plug it back in.
l A USB-connected printer on a Windows 11 system may be placed in offline status

following an update to the Card Printer Driver from a previous version. Do the following

to return the printer to online status:

1. Select Start > Settings > Devices > Printers & Scanners.

2. Select the GDI Card Printer and clickOpen Queue.

3. Click the Printermenu and remove the check mark next to Use Printer Offline.

Update or Uninstall Cannot Complete
The Card Printer Driver occasionally issues a message that it cannot complete an update or

uninstall because there are active print jobs. This situation can occur even when all printers

have been removed as part of the uninstall. Do the following to resolve the issue.
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1. Open a command prompt window. Select Run as administratorwhen opening the
window.

2. Enter the following command:

net stop spooler

A message displays when the spooler has stopped successfully.

3. Open the C:\Windows\System32\spool\PRINTERS folder on your computer. Delete all

files from the folder.

4. In the command prompt window, enter the following command:

net start spooler

i You also can shut down and restart the computer to start the

spooler.

A message displays when the spooler has started.

The Card Printer Driver now can be updated or uninstalled.

Antivirus Software Troubleshooting
Antivirus software updates are typically managed by your corporate IT department and

deployed across the network. Due to strict security policies and frequent updates, Entrust

does not lead this process. Maintain system performance by excluding specific directories

from real-time antivirus scanning and run full-system scans during non-production hours.

i Users are responsible for validating and implementing antivirus

software updates.

Additional Driver Troubleshooting
Messages Linking to Incorrect Printer URL

Problem: For all error messages, the driver might link to incorrect printer when clicking the
Help button.

Solution: To display help for other printers, use the following URL link and replace the xxx at
the end with the corresponding error code.

l To display Sigma printer errors the URL is

https://www.entrust.com/knowledgebase/hardware/error-code-xxx-14

Message 100 Request Not Supported

Problem:Message 100 request not supported.

Cause: This issue occurs when:
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l User has changed the ribbon on printer.
l User has updated the printer IP address on the ports tab.
l User has connected a different printer to the driver.

Solution:

l User should open the Printer Properties Window and select the Printer Status tab and
click Ask Printer for Update to get the latest information from the printer.

l User should open the Printer Properties Window and select the Supplies tab and click
Ask Printer for Update to get the latest information from the printer.

Card Not Printing Correctly

Problem: The card is not printing correctly and is using the incorrect ribbon type.

Cause: This issue occurs when:

l User has changed the ribbon on printer.
l User has updated the printer IP address on the ports tab.
l User has connected a different printer to the driver.

Solution:

l User should open the Printer Properties Window and select the Printer Status tab and
click Ask Printer for Update to get the latest information from the printer.

l User should open the Printer Properties Window and select the Supplies tab and click
Ask Printer for Update to get the latest information from the printer.

Card Not Printing as Expected from User Account

Problem: The printing is not coming out as expected when logged on with a regular user
account. When on Admin account, everything looks as it should. This is because the user

does not have the proper permissions.

Solution: From the Admin account, give the user permission to access all features. Go to the

Security Tab and follow the steps from Security Tab on page 34 to set the printer

permissions and allow user access to all features.

Advanced Troubleshooting Tools
For additional troubleshooting topics, refer to the printer’s User’s Guide.

Printer Manager and the Printer Dashboard also provide additional troubleshooting tools.

Refer to the printer’s Installation and Administrator’s Guide for information about using

Printer Manager, or the Printer Dashboard Help.
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